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Introduction
The PIC16F15244 family of microcontrollers incorporates simplified analog core features, digital communication
peripherals, timers, and waveform generators. This microcontroller family also provides flexible memory features,
such as the Memory Access Partition (MAP) and Device Information Area (DIA).

This document is intended to enable the new PIC16F15244 family users to get a basic hardware and software
understanding of the PIC16F15244 family and get started with software development for the PIC16F15244 family of
microcontrollers.

This document provides an overview of the PIC16F15244 family and associated technical collateral provided by
Microchip.

To understand more about the PIC16F15244 family core features, memory, operating characteristics, power
saving functionalities, digital peripherals, analog peripherals, clock structures and features overview, refer to the
PIC16F15244 Family device data sheet.

Features
This quick start guide features the following content:

• Product Family Introduction
• Relevant Devices
• Code Examples on GitHub
• Tools Ecosystem
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1. Relevant Devices
The PIC16F15244 family products are available in 8/14/16/20/28/40/44-pin packages for cost-sensitive sensor and
real-time control applications. The PIC16F15244 family of microcontrollers offers up to 28 KB of Flash memory, up to
2 KB of SRAM, and it also provides memory features. The PIC16F15244 family of microcontrollers offers a rich set of
core features, memory functionalities, power-saving abilities, digital and analog peripherals.

Figure 1-1. Overview of PIC16F15244 Family of Microcontrollers
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2. Device References

2.1 Product Pages
• PIC16F15213: https://www.microchip.com/wwwproducts/en/PIC16F15213
• PIC16F15214: https://www.microchip.com/wwwproducts/en/PIC16F15214
• PIC16F15223: https://www.microchip.com/wwwproducts/en/PIC16F15223
• PIC16F15224: https://www.microchip.com/wwwproducts/en/PIC16F15224
• PIC16F15225: https://www.microchip.com/wwwproducts/en/PIC16F15225
• PIC16F15243: https://www.microchip.com/wwwproducts/en/PIC16F15243
• PIC16F15244: https://www.microchip.com/wwwproducts/en/PIC16F15244
• PIC16F15245: https://www.microchip.com/wwwproducts/en/PIC16F15245
• PIC16F15254: https://www.microchip.com/wwwproducts/en/PIC16F15254
• PIC16F15255: https://www.microchip.com/wwwproducts/en/PIC16F15255
• PIC16F15256: https://www.microchip.com/wwwproducts/en/PIC16F15256
• PIC16F15274: https://www.microchip.com/wwwproducts/en/PIC16F15274
• PIC16F15275: https://www.microchip.com/wwwproducts/en/PIC16F15275
• PIC16F15276: https://www.microchip.com/wwwproducts/en/PIC16F15276

2.2 Documents
• Migration Document:

– Migration from PIC12F to PIC16F15244 Microcontroller Family
• Data Sheets:

– PIC16F15213/14/23/24/43/44 Full-Featured 8/14/20-Pin Microcontrollers
– PIC16F15225/45 Full-Featured 14/20-Pin Microcontrollers
– PIC16F15256/74/75/76 28/40-Pin Microcontrollers
– PIC16F15254/55 28-Pin Microcontrollers

• Product Brief:
– PIC16F15244 Family Product Brief

• Errata:
– PIC16F15213/14/23/24/43/44 Silicon Errata and Data Sheet Clarifications
– PIC16F15225/45 Silicon Errata and Data Sheet Clarifications
– PIC16F15256/74/75/76 Silicon Errata and Datasheet Clarifications
– PIC16F15254/55 Silicon Errata and Data Sheet Clarifications

• Programming Specification:
– PIC16F15244 Family Programming Specification
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3. Code Examples
The code examples for the PIC16F15244 family and examples associated with different peripherals such as MSSP,
PWM, WDT, EUSART, and Timers are available through GitHub.

Find code examples for the PIC16F15244 family of microcontrollers by searching the device name (e.g.,
PIC16F15244) in the GitHub microchip-pic-avr-examples repository. Microchip also enables users to find the desired
code examples using the Microchip Discover Portal.

View Code Examples on GitHub
Click to browse repositories

The code can be downloaded as a .zip file or can be cloned as a Git repository.

 PIC16F15244 Quick Start Guide
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4. Development Tools
The PIC16F15244 family of microcontrollers supports multiple hardware and software platforms for programming and
debugging. Developers can choose the appropriate evaluation kits, programmers, and debuggers for their application
development.

This quick start guide covers the available supporting development tools ecosystem to help developers get started
with application development using the PIC16F15244 family of microcontrollers.

 PIC16F15244 Quick Start Guide
Development Tools
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5. Hardware Tools

5.1 Evaluation Kits
PIC16F15244/76 Curiosity Nano Evaluation Kit

The PIC16F15244/76 Curiosity Nano Evaluation Kit is a hardware platform to evaluate PIC16F15244/76
microcontrollers which provides easy access to the features of the microcontrollers. The Curiosity Nano Evaluation
Kits include an on-board debugger (EDBG), which means that there is no need for external tools for programming
and debugging the PIC16F15244/76 microcontroller.
Figure 5-1. Overview of PIC16F15244 Curiosity Nano Kit

Web Page:https://www.microchip.com/developmenttools/productdetails/partno/EV09Z19A

Get the Kit: https://www.microchipdirect.com/dev-tools/EV09Z19A?productLoaded=true&allDevTools=true

Figure 5-2. Overview of PIC16F15276 Curiosity Nano Kit

Web Page: https://www.microchip.com/DevelopmentTools/ProductDetails/PartNO/EV35F40A

Get the Kit: https://www.microchipdirect.com/dev-tools/EV35F40A?productLoaded=true&allDevTools=true

Features:

• PIC16F15244/76 Microcontroller
• One Yellow User LED
• One Mechanical User Switch
• On-Board Debugger:

– Board identification in MPLAB® X Integrated Development Environment (IDE)
– One green power and status LED

 PIC16F15244 Quick Start Guide
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– Programming and debugging
– Virtual COM port (CDC) for microcontroller to PC communication
– Data Gateway Interface (DGI): one GPIO
– USB Powered

For more details, refer to the PIC16F15244 Curiosity Nano Hardware User Guide or the PIC16F15276 Curiosity
Nano Hardware User Guide.

Curiosity Nano Base for Click Boards™ Evaluation Kit

The Curiosity Nano Base for Click Boards evaluation kit is a hardware extension platform intended to ease the
connection between the Curiosity Nano evaluation kit, the mikroBUS Click boards, and the Xplained Pro extension
kits.

Figure 5-3. Overview of Curiosity Nano Base for Click Boards

Web Page: https://www.microchip.com/DevelopmentTools/ProductDetails/PartNO/AC164162

Get the Kit: https://www.microchipdirect.com/dev-tools/AC164162?productLoaded=true&allDevTools=true

Features:

• Curiosity Nano Footprint
• One Power LED
• Three mikroBUS™ Sockets
• One Xplained Pro Extension Header
• Power:

– USB powered from the Curiosity Nano kit
– Alternative external power input
– Option to power from, and charge, 4.20V Li-Ion/LiPo batteries
– Fixed 3.3V PSU for target and mikroBUS sockets
– Fixed 5.0V Boost converter for 5V mikroBUS sockets

For more details, refer to the Curiosity Nano Base for Click boards User Guide: ww1.microchip.com/downloads/en/
DeviceDoc/Curiosity-Nano-Base-for-Click-boards-User-Guide-50002839B.pdf

Microchip Curiosity High Pin Count Development Evaluation Kit

The Microchip Curiosity High Pin Count (HPC) Development kit supports Microchip’s 8-Pin, 14-Pin, 20-Pin, and
40-Pin 8-bit PIC microcontrollers. The expansion headers on either side of the microcontroller socket provide access
to all pins on the PIC microcontroller.

 PIC16F15244 Quick Start Guide
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Figure 5-4. Overview of Curiosity High Pin Count Kit

Web Page: https://www.microchip.com/DevelopmentTools/ProductDetails/PartNO/DM164136

Get the Kit: https://www.microchipdirect.com/dev-tools/DM164136?allDevTools=true

Features:

• MPLAB® X Integrated Development Environment (IDE) compatibility
• Programming and debugging support
• Powered from USB, with option jumper for 3.3/5V
• Master Clear (MCLR) Reset
• Dual-row expansion headers
• PIC® MCU PDIP sockets for 28-pin and 40-pin microcontrollers
• Two mikroBUS sockets
• Four indication LEDs
• Two push buttons
• One potentiometer

For more details, refer to the Curiosity High Pin Count Development Board User Guide: ww1.microchip.com/
downloads/en/DeviceDoc/Curiosity-High-Pin-Count-Development-Board-User-Guide-40001856C.pdf

5.2 Programmers and Debuggers
Microchip offers a range of programmers, debuggers, and extensions to support all device architectures. All
solutions/in-circuit debuggers and programmers are USB-powered and fully integrated into their respective
environments. MPLAB ICD 4 In-Circuit Debugger offers debug and hardware features sufficient for most users.
MPLAB Snap In-Circuit and MPLAB PICkit 4 In-Circuit Debuggers are economical choices for fundamental
debugging functionalities.

• MPLAB PICkit 4 In-Circuit Debugger
– Product Page
– Buy Here
– User Guide
– Microchip Developer Help

• MPLAB ICD 4 In-Circuit Debugger
– Product Page
– Buy Here
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– User Guide
– Microchip Developer Help

• MPLAB Snap In-Circuit Debugger
– Product Page
– Buy Here
– User Guide
– Microchip Developer Help

The figure below shows the various types of programmers and debuggers offered by Microchip.

Figure 5-5. Microchip Programmers and Debuggers

MPLAB PICkit 4 MPLAB ICD 4 MPLAB SNAP
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6. Software Tools
MPLAB X Integrated Development Environment (IDE)

MPLAB X IDE is a software program that runs on a PC (Windows®, Mac OS®, Linux®) for the development of
applications for Microchip microcontrollers. It is called an Integrated Development Environment because it provides a
single integrated environment to develop code for embedded microcontrollers.

MPLAB Code Configurator (MCC)

MPLAB MCC is a free, graphical programming environment that generates seamless, easy-to understand C code
to be included into the project. Using an intuitive interface, it enables and configures a rich set of peripherals and
functions specific to application development.

There are three ways to get the MCC software to development environment:

• Use MPLAB® Xpress Cloud-Based IDE
• Install the MPLAB X IDE Plug-In
• Install the MPLAB Code Configurator (MCC)

MCC Features:

• An easy-to-install MPLAB X IDE plug-in
• A list of available peripherals
• Easy selection of the peripheral configuration
• Integration of the MCC Code into an existing project or start a new project from scratch
• Simple removal of peripherals
• Retention of changes to generated code
• Generation and usage of specialized and standardized drivers

MPLAB® XC8 C Compiler

The optimizations found on the MPLAB XC8 provide code size reductions and speed enhancements that benefit
design projects. A PRO license is available for designs that require maximum code reductions and best performance.
The MPLAB XC8 C Compiler contains a free, 60-day trial of a PRO license for evaluation when activated. Also, the
MPLAB XC8 is TÜV SÜD certified.

Figure 6-1. Microchip Software Tools

MPLAB CODE CONFIGURATOR (MCC)MPLAB X IDE MPLAB XC8 COMPLIER
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7. Recommended Programming and Debugging Tools
• MPLAB PICkit 4 In-Circuit Debugger

– User Guide: ww1.microchip.com/downloads/en/DeviceDoc/50002751F.pdf
– How to Buy: www.microchipdirect.com/dev-tools/PG164140?productLoaded=true&amp;allDevTools=true

• MPLAB ICD 4 In-Circuit Debugger
– User Guide: ww1.microchip.com/downloads/en/DeviceDoc/50002596E.pdf
– How to Buy: www.microchipdirect.com/dev-tools/DV164045?productLoaded=true&amp;allDevTools=true
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8. What’s Next
For further information on products and related documents, refer to the links below:

• Migration guide:
– Migration from PIC12F to PIC16F15244 Microcontroller Family

• Application Notes:
– PID Fan Speed Control for 4-Wire Fans
– Simple LiPo Battery Management
– A Simple Water Monitoring System with I2C Communication

• Technical Briefs:
– Using the I2C in Host Mode
– Using the I2C in Client Mode
– Using PWM to Generate an Analog Output

• For more information about project creation and debugging, refer to the MPLAB X Quick Start Guide.
• For generating the device drivers using MPLAB MCC, refer to the MPLAB MCC guide.
• PIC16F Functional Safety Guide
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9. Appendix

9.1 Project Creation with MPLAB® X Integrated Development Environment (IDE) and
MPLAB® Code Configurator (MCC)
Prerequisites

• Install MPLAB X IDE v5.50 or the latest version.
• Install MPLAB MCC v4.2.1 or the latest version available as plug-in.
• Install DFP package from the Packs, which provides device support in the IDE.

The following page will appear when PIC16F15244 Curiosity Nano is connected to MPLAB X IDE through USB.
Figure 9-1. MPLAB® Kit Window

1. Create a new project by going to File >New Project or by clicking the shortcut Ctrl+Shift+N.
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Figure 9-2. MPLAB® X IDE Project Creation Window

2. Select Microchip Embedded in the Categories window and Standalone Project in Projects window and click
Next.
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Figure 9-3. Project Categories and Project Type Selection Window

3. Enter the device (PIC16F15244), select PIC16F15244 Curiosity Nano from the Tool drop-down list, then click
Next .
Figure 9-4. Device Selection Window

4. After the microcontroller is selected, select the XC8 Compiler and click Next.

 PIC16F15244 Quick Start Guide
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Figure 9-5. Compiler Selection Window

5. Type the name of the project in the “Project Name” field, e.g., LedToggle, (blank space, brackets, semicolons,
and special characters are not allowed). Then, navigate to the desired project location (e.g., D:/Microchip) and
click on Finish.

 PIC16F15244 Quick Start Guide
Appendix
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Figure 9-6. Project Name and Folder Window

6. To initialize and configure the project, click on the MCC icon.

Important:  To install MCC in MPLAB X IDE, select Tools>Plugins>Available Plugins and click
MPLAB Code Configurator option and then click Install.

 PIC16F15244 Quick Start Guide
Appendix
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Figure 9-7. Icon to Open MCC

7. The Resource Management MCC window will open. Configure the system clock by clicking on the Clock
Control option under the System module of the Project Resource section. Select the clock as HFINTOSC (1
MHz) from the Clock Source drop-down list.
Figure 9-8. MCC System Configuration Window

 PIC16F15244 Quick Start Guide
Appendix
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8. The GPIO configuration of the LED with MCC is selected in the Pin Manager: Grid View window, as shown
below. Set the name for GPIO pin RA2 to ‘LED', as it is easier to remember when developing source code
later.
Figure 9-9. MPLAB® MCC Pin Configuration Window

9. To generate the configured MCC project, click on the Generate button under the Resource Management tab.
The output of the generator is viewable in the MPLAB Code Configurator window.
Figure 9-10. MCC Firmware Generation Output

10. Add the code to toggle the LED in the main.c file, located in the Projects window, under the Source Files
folder. Copy and paste the following code inside the while (1) loop.

#include "mcc_generated_files/system/system.h"

#define _XTAL_FREQ 1000000

 PIC16F15244 Quick Start Guide
Appendix
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/*
    Main application
*/

int main(void)
{
    SYSTEM_Initialize();

    while(1)
    {
        LED_Toggle();              //Toggle LED
        __delay_ms(500);            //500ms delay
    }    
}

11. Build the project by clicking on Clean and Build Main Project icon, to check that there are not any build
errors in the project.
Figure 9-11. Building and Cleaning the Project

12. Program the project to the PIC16F15244 Curiosity Nano board by clicking on the Make and Program Device
icon.

 PIC16F15244 Quick Start Guide
Appendix
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Figure 9-12. Make and Device Programming

13. Verify that the LED is toggling on the PIC16F15244 Curiosity Nano board.

9.2 Optional Steps
1. To create an additional source .c/.h file, go to File>New File or by using the shortcut Ctrl+N.

Figure 9-13. New File Creation Window

2. Select the Categories>C and File Types>C>Source File>Main File/Header File, then click Next.

 PIC16F15244 Quick Start Guide
Appendix
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Figure 9-14. File Type Selection Window

3. Type the file name in the ‘File Name’ field and click Finish.
Figure 9-15. File Name Field Window

 PIC16F15244 Quick Start Guide
Appendix
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The Microchip Website
Microchip provides online support via our website at www.microchip.com/. This website is used to make files and
information easily available to customers. Some of the content available includes:

• Product Support – Data sheets and errata, application notes and sample programs, design resources, user’s
guides and hardware support documents, latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical support requests, online
discussion groups, Microchip design partner program member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip press releases, listing of
seminars and events, listings of Microchip sales offices, distributors and factory representatives

Product Change Notification Service
Microchip’s product change notification service helps keep customers current on Microchip products. Subscribers will
receive email notification whenever there are changes, updates, revisions or errata related to a specified product
family or development tool of interest.

To register, go to www.microchip.com/pcn and follow the registration instructions.

Customer Support
Users of Microchip products can receive assistance through several channels:

• Distributor or Representative
• Local Sales Office
• Embedded Solutions Engineer (ESE)
• Technical Support

Customers should contact their distributor, representative or ESE for support. Local sales offices are also available to
help customers. A listing of sales offices and locations is included in this document.

Technical support is available through the website at: www.microchip.com/support

Microchip Devices Code Protection Feature
Note the following details of the code protection feature on Microchip products:

• Microchip products meet the specifications contained in their particular Microchip Data Sheet.
• Microchip believes that its family of products is secure when used in the intended manner, within operating

specifications, and under normal conditions.
• Microchip values and aggressively protects its intellectual property rights. Attempts to breach the code

protection features of Microchip product is strictly prohibited and may violate the Digital Millennium Copyright
Act.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. Code
protection does not mean that we are guaranteeing the product is “unbreakable”. Code protection is constantly
evolving. Microchip is committed to continuously improving the code protection features of our products.

Legal Notice
This publication and the information herein may be used only with Microchip products, including to design, test,
and integrate Microchip products with your application. Use of this information in any other manner violates these
terms. Information regarding device applications is provided only for your convenience and may be superseded
by updates. It is your responsibility to ensure that your application meets with your specifications. Contact your
local Microchip sales office for additional support or, obtain additional support at www.microchip.com/en-us/support/
design-help/client-support-services.
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THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS". MICROCHIP MAKES NO REPRESENTATIONS
OR WARRANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED, WRITTEN OR ORAL, STATUTORY
OR OTHERWISE, RELATED TO THE INFORMATION INCLUDING BUT NOT LIMITED TO ANY IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY, AND FITNESS FOR A PARTICULAR PURPOSE,
OR WARRANTIES RELATED TO ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL, OR
CONSEQUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY KIND WHATSOEVER RELATED TO THE
INFORMATION OR ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS BEEN ADVISED OF THE
POSSIBILITY OR THE DAMAGES ARE FORESEEABLE. TO THE FULLEST EXTENT ALLOWED BY LAW,
MICROCHIP'S TOTAL LIABILITY ON ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION OR ITS USE
WILL NOT EXCEED THE AMOUNT OF FEES, IF ANY, THAT YOU HAVE PAID DIRECTLY TO MICROCHIP FOR
THE INFORMATION.

Use of Microchip devices in life support and/or safety applications is entirely at the buyer's risk, and the buyer agrees
to defend, indemnify and hold harmless Microchip from any and all damages, claims, suits, or expenses resulting
from such use. No licenses are conveyed, implicitly or otherwise, under any Microchip intellectual property rights
unless otherwise stated.

Trademarks
The Microchip name and logo, the Microchip logo, Adaptec, AnyRate, AVR, AVR logo, AVR Freaks, BesTime,
BitCloud, chipKIT, chipKIT logo, CryptoMemory, CryptoRF, dsPIC, FlashFlex, flexPWR, HELDO, IGLOO, JukeBlox,
KeeLoq, Kleer, LANCheck, LinkMD, maXStylus, maXTouch, MediaLB, megaAVR, Microsemi, Microsemi logo,
MOST, MOST logo, MPLAB, OptoLyzer, PackeTime, PIC, picoPower, PICSTART, PIC32 logo, PolarFire, Prochip
Designer, QTouch, SAM-BA, SenGenuity, SpyNIC, SST, SST Logo, SuperFlash, Symmetricom, SyncServer,
Tachyon, TimeSource, tinyAVR, UNI/O, Vectron, and XMEGA are registered trademarks of Microchip Technology
Incorporated in the U.S.A. and other countries.

AgileSwitch, APT, ClockWorks, The Embedded Control Solutions Company, EtherSynch, FlashTec, Hyper Speed
Control, HyperLight Load, IntelliMOS, Libero, motorBench, mTouch, Powermite 3, Precision Edge, ProASIC,
ProASIC Plus, ProASIC Plus logo, Quiet-Wire, SmartFusion, SyncWorld, Temux, TimeCesium, TimeHub, TimePictra,
TimeProvider, WinPath, and ZL are registered trademarks of Microchip Technology Incorporated in the U.S.A.

Adjacent Key Suppression, AKS, Analog-for-the-Digital Age, Any Capacitor, AnyIn, AnyOut, Augmented Switching,
BlueSky, BodyCom, CodeGuard, CryptoAuthentication, CryptoAutomotive, CryptoCompanion, CryptoController,
dsPICDEM, dsPICDEM.net, Dynamic Average Matching, DAM, ECAN, Espresso T1S, EtherGREEN, IdealBridge,
In-Circuit Serial Programming, ICSP, INICnet, Intelligent Paralleling, Inter-Chip Connectivity, JitterBlocker, maxCrypto,
maxView, memBrain, Mindi, MiWi, MPASM, MPF, MPLAB Certified logo, MPLIB, MPLINK, MultiTRAK, NetDetach,
Omniscient Code Generation, PICDEM, PICDEM.net, PICkit, PICtail, PowerSmart, PureSilicon, QMatrix, REAL ICE,
Ripple Blocker, RTAX, RTG4, SAM-ICE, Serial Quad I/O, simpleMAP, SimpliPHY, SmartBuffer, SMART-I.S., storClad,
SQI, SuperSwitcher, SuperSwitcher II, Switchtec, SynchroPHY, Total Endurance, TSHARC, USBCheck, VariSense,
VectorBlox, VeriPHY, ViewSpan, WiperLock, XpressConnect, and ZENA are trademarks of Microchip Technology
Incorporated in the U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated in the U.S.A.

The Adaptec logo, Frequency on Demand, Silicon Storage Technology, and Symmcom are registered trademarks of
Microchip Technology Inc. in other countries.

GestIC is a registered trademark of Microchip Technology Germany II GmbH & Co. KG, a subsidiary of Microchip
Technology Inc., in other countries.

All other trademarks mentioned herein are property of their respective companies.
© 2021, Microchip Technology Incorporated, Printed in the U.S.A., All Rights Reserved.

ISBN: 978-1-5224-8562-9

Quality Management System
For information regarding Microchip’s Quality Management Systems, please visit www.microchip.com/quality.
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AMERICAS ASIA/PACIFIC ASIA/PACIFIC EUROPE
Corporate Office
2355 West Chandler Blvd.
Chandler, AZ 85224-6199
Tel: 480-792-7200
Fax: 480-792-7277
Technical Support:
www.microchip.com/support
Web Address:
www.microchip.com
Atlanta
Duluth, GA
Tel: 678-957-9614
Fax: 678-957-1455
Austin, TX
Tel: 512-257-3370
Boston
Westborough, MA
Tel: 774-760-0087
Fax: 774-760-0088
Chicago
Itasca, IL
Tel: 630-285-0071
Fax: 630-285-0075
Dallas
Addison, TX
Tel: 972-818-7423
Fax: 972-818-2924
Detroit
Novi, MI
Tel: 248-848-4000
Houston, TX
Tel: 281-894-5983
Indianapolis
Noblesville, IN
Tel: 317-773-8323
Fax: 317-773-5453
Tel: 317-536-2380
Los Angeles
Mission Viejo, CA
Tel: 949-462-9523
Fax: 949-462-9608
Tel: 951-273-7800
Raleigh, NC
Tel: 919-844-7510
New York, NY
Tel: 631-435-6000
San Jose, CA
Tel: 408-735-9110
Tel: 408-436-4270
Canada - Toronto
Tel: 905-695-1980
Fax: 905-695-2078

Australia - Sydney
Tel: 61-2-9868-6733
China - Beijing
Tel: 86-10-8569-7000
China - Chengdu
Tel: 86-28-8665-5511
China - Chongqing
Tel: 86-23-8980-9588
China - Dongguan
Tel: 86-769-8702-9880
China - Guangzhou
Tel: 86-20-8755-8029
China - Hangzhou
Tel: 86-571-8792-8115
China - Hong Kong SAR
Tel: 852-2943-5100
China - Nanjing
Tel: 86-25-8473-2460
China - Qingdao
Tel: 86-532-8502-7355
China - Shanghai
Tel: 86-21-3326-8000
China - Shenyang
Tel: 86-24-2334-2829
China - Shenzhen
Tel: 86-755-8864-2200
China - Suzhou
Tel: 86-186-6233-1526
China - Wuhan
Tel: 86-27-5980-5300
China - Xian
Tel: 86-29-8833-7252
China - Xiamen
Tel: 86-592-2388138
China - Zhuhai
Tel: 86-756-3210040

India - Bangalore
Tel: 91-80-3090-4444
India - New Delhi
Tel: 91-11-4160-8631
India - Pune
Tel: 91-20-4121-0141
Japan - Osaka
Tel: 81-6-6152-7160
Japan - Tokyo
Tel: 81-3-6880- 3770
Korea - Daegu
Tel: 82-53-744-4301
Korea - Seoul
Tel: 82-2-554-7200
Malaysia - Kuala Lumpur
Tel: 60-3-7651-7906
Malaysia - Penang
Tel: 60-4-227-8870
Philippines - Manila
Tel: 63-2-634-9065
Singapore
Tel: 65-6334-8870
Taiwan - Hsin Chu
Tel: 886-3-577-8366
Taiwan - Kaohsiung
Tel: 886-7-213-7830
Taiwan - Taipei
Tel: 886-2-2508-8600
Thailand - Bangkok
Tel: 66-2-694-1351
Vietnam - Ho Chi Minh
Tel: 84-28-5448-2100

Austria - Wels
Tel: 43-7242-2244-39
Fax: 43-7242-2244-393
Denmark - Copenhagen
Tel: 45-4485-5910
Fax: 45-4485-2829
Finland - Espoo
Tel: 358-9-4520-820
France - Paris
Tel: 33-1-69-53-63-20
Fax: 33-1-69-30-90-79
Germany - Garching
Tel: 49-8931-9700
Germany - Haan
Tel: 49-2129-3766400
Germany - Heilbronn
Tel: 49-7131-72400
Germany - Karlsruhe
Tel: 49-721-625370
Germany - Munich
Tel: 49-89-627-144-0
Fax: 49-89-627-144-44
Germany - Rosenheim
Tel: 49-8031-354-560
Israel - Ra’anana
Tel: 972-9-744-7705
Italy - Milan
Tel: 39-0331-742611
Fax: 39-0331-466781
Italy - Padova
Tel: 39-049-7625286
Netherlands - Drunen
Tel: 31-416-690399
Fax: 31-416-690340
Norway - Trondheim
Tel: 47-72884388
Poland - Warsaw
Tel: 48-22-3325737
Romania - Bucharest
Tel: 40-21-407-87-50
Spain - Madrid
Tel: 34-91-708-08-90
Fax: 34-91-708-08-91
Sweden - Gothenberg
Tel: 46-31-704-60-40
Sweden - Stockholm
Tel: 46-8-5090-4654
UK - Wokingham
Tel: 44-118-921-5800
Fax: 44-118-921-5820
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